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Abstract

The purpose of this paper is to provide a step by step description of how to use the Electronic
Battle Box (EBB suite v.2.1) to generate and analyse logistics data. The first section provides a
quick introduction of the EBB Suite tools and their usual usage sequence. The second section
defines a context for the EBB Suite guided tour. This is constituted mostly from extracts of an
operation order at the brigade level that has been reorganised to fit the EBB Suite structure.
Finally, in order to generate data in accordance with the tactical operations requirements, the
extracted information is entered within the EBB Suite browsers and processed in multiple ways,
using a different EBB planner tool each time.

Résumé

Le but du présent rapport consiste en une description détaillée des étapes d’utilisation du coffre
de campagne informatisé (CCI v2.1) dans la génération de données logistiques. Dans une
premiére section, les principaux outils du CCl et leur séquence d’utilisation sont exposés
rapidement. La deuxiéme section définit un contexte d’utilisation particulier. Il s’agit d’extraits
tirés a partir d’un ordre d’opération au niveau brigade, réorganisés selon la structure du CCI.
Finalement, afin de générer des données logistiques en fonction des exigences particuliéres des
opérations tactiques, I’information extraite est définie au niveau des navigateurs du CCI et traitée
de diverses facons, utilisant a tour de réle les nombreux outils de planification offerts par le CCI.



INTRODUCTION

1. The crucial step in the process of building a model is data collection. All organisations keep
track of various data on their operations, but often these data might not be in the form required by
the analyst. Data might also be scattered in different places throughout the organisation, in a variety
of formats. Therefore, one of the first jobs of the analyst is to gather exactly the right data and put it
into the right form required by the model. This typically requires asking questions to key people
throughout the organisation, studying existing organisational databases and tools and performing
time-consuming observational studies of different scenarios in order to choose the one which best
answers the needs of the study. In short, it usually entails a lot of legwork.

2. Another approach to that long tedious process is the generation of your own data. For
logistics matters, there exists a new powerful tool that can be used to generate valuable data. The
Electronic Battle Box Suite (EBB Suite v.2.1) is in fact an excellent software package to access a
large number of doctrinal documents, databases and new logistic and movement planning tools. All
that is needed is to extract the right information from an operation order, transform it in the way
required by the EBB Suite and generate data in accordance with the mission statement and the
execution of the concept of operation.

3. What follows is a step-by-step description of how to use the EBB suite to generate relevant
data. The first section introduces the EBB Suite’s components. The second section describes what
information to extract from an operation order and how to reorganise it in order to use the EBB Suite
efficiently. Finally, this information is entered within the EBB Suite, processed in multiple ways,
and the different data related to the operation displayed each time.



SECTION 1: THE EBB SUITE

4. The EBB Suite is composed of nine different tools including one binder, three browsers and
five planners. The binder is the entry point to access the browsers and planners of the Suite. The
browsers are used to browse and enter the information and parameters related to the operation, while
the planners are used to provide various calculation results based on the information specified in the
browsers. Figure 1 presents the suggested usage sequence for tools. An arrow linking two tools
means that some data created by one tool are required by the other. For example, from this schema, a
logistic option should be estimated before going in the Lift Planner.

EBB Suite Tools

Theﬂlm:ler B =

Fouml Muwiail

EEB Hinder
Mamer

Lift P lanner

:

Thie Emrws by

[ quipmen: Orbat Task |} || Logistic
Browser Browsar Browser | : 7 Plamner

b 3
x

Ml Movomnord ™| Ar Mvement
Planner Marner

Figure 1: The EBB Suite Tools Usage Sequence

5. The EBB tools usual sequence can also be represented in a circular manner as indicated in
figure 2. In fact, once the desired options with the planners have been created, the user can go back
to the browsers, do some modifications and then look at the impacts of this change on the existing
options. This is particularly interesting in a military context often dominated by ever-changing
circumstances that create the need to constantly adjust the number of personnel and equipment
available to the units, as well as the tasks that were first assigned to them.
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Figure 2: The EBB Suite Browsers and planners

6. The step-by-step guided tour of the EBB Suite will follow the described sequence as
indicated in figure 2, starting with the Orbat browser and ending with the rail movement planner.
Note that the equipment browser will not be described, since a doctrinal equipment browser is
already integrated within all the others tools. But before going any further, there is the need to define

a context for the EBB guided tour.



SECTION 2: CONTEXT OF THE GUIDED TOUR

7. This section provides the context of the guided tour. It consists of a general mission
statement, followed by a concept of operation and all the details to be executed. Any operation order
can serve that purpose. However, only a specific part of information displayed on the operation
order will be used. In addition to that, the extracted information needs to be reorganised in order to
fit the EBB Suite structure.

8. For the present exercise, the 12 CIB operation order at the annex A will be used. In order to
keep the information easily manageable, it is grouped for the most part in tables. Some details are
directly taken from the 12 CIB operation order, while others are deductions based on military
judgement. What follows constitutes the basic information needed to extract or deduce from the 12
CIB operation order before using the EBB Suite.

Concept of operation

9. The 12 CIB concept of operation is to regroup in assembly area THUNDER BAY and to
rapidly advance to BIG TOP three up (1 R de Mais LEFT, 1 E&K Scot CENTRE, 1 CH of O
RIGHT) and R de Hull minus in DEPTH. Recce Squadron will screen forward and confirm crossing
sites and gaps. Anti-armour Company will assist in flank security. The brigade main effort in
sequence is to seize objectives B1 and B2 then C. The brigade endstate is to consolidate on highway
8/9A facing NORTH. At the end of phase 3, 12 CIB will be airlifted towards BERLIN. The airlift
of 12 CIB personnel will use Hercules aircraft whereas the equipment will be loaded on C-17A
aircraft.

Operation phases

10. The 12 CIB operation is a five-phased operation. It is assumed that it starts at D-1, H-24 and
ends at D+7, H+180. Phases 0 and 1 last 24 hours each. Phases 2 and 3 require respectively three
days each to be completed, while phase 4 is accomplished in 12 hours. Table 1 provides a
description of each of the five phases.

Table 1: Operation phases

Description Length
Phase 0 Road move to assy area Thunder Bay 1 day
Phase 1 Advance to BIG TOP 1 day
Phase 2 Fix A and seize B1 and B2 3 days
Phase 3 Seize A and C1 and C2 3 days
Phase 4 Airlift to BERLIN 12 hours
Tasks of the units
11. Although it is not indicated on the operation order, it is important to know during which step

of the five-phase operation each task is accomplished. For the purpose of this exercise, it is
assumed that a task should start and finish within the same phase. Also, to make it easier, it is
assumed that units will take the whole period of time allocated to a phase to complete a task. When

4



units have to deal with more than one task, the phases are simply split equally between the tasks. For
example, a unit which has to conduct two tasks during phase 3, will execute one at a time, taking an
equal amount of time to accomplish each one. Table 1 displays the different tasks assigned to the 12

CIB units during phases 1, 2 and 3. Since the tasks under phases 0 and 4 are the same for all the
units (road move and air move), they are intentionally omitted.

Table 2 : Tasks of the units

Unit Phase 1 Phase 2 Phase 3
12 E de Reco | Screen Forward of the | Attempt to screen the Screen forward of highway
brigade advance to BIG | RIGHT flank from BIG 8/9A in preparation for the
TOP and establish TOP to BILLY BOB brigade advance to objective
enemy positions and LAMB
possible crossing sites
R de Hull Reserve Advance to BIG TOP and | On order seize objective C1
establish a waiting area in
the area of GR 2600 Consolidate along Highways
8/9A and be prepared to
advance to objective LAMB
1 E&K Scot | Advance CENTRE Seize objective B1 Seize objective A
Forward
Consolidate along highways
8/9A and be prepared to
advance to objective LAMB
1 R de Mais | Advance LEFT forward | Fix enemy in objective A | Cross BIG TOP in the area
of objective B1
Provide one company as
brigade reserve until phase | Consolidate along highway
3 8/9A and be prepared to
advance to objective LAMB
1CHofO Advance RIGHT Seize objective B2 On order seize objective C2
forward
Consolidate along highway
8/9A and be prepared to
advance to objective LAMB
B Coy LEFT flank security
R West R throughout

Combat Parameters

12. The combat parameters are not explicitly defined in the operation order, but can be easily
deduced from the concept of operations. The combat intensity, posture, equipment combat (EC) rate
and personal casualty (PC) rate are the parameters that are needed to be defined for each unit.
However, the choice of definition is limited to the parameter options as set in the EBB Suite. Table
3 summarises the result of deductions about the combat parameters for the 12 CIB operation.




Table 3: Combat parameters

Unit Phase 1 Phase 2 Phase 3
12 E de Reco | Moderate intensity Moderate intensity Moderate intensity
Reserve posture Reserve posture Reserve posture
ECrate:1 ECrate: 1 ECrate: 1
PC rate: 0.028 PC rate: 0.028 PC rate: 0.028
R de Hull Reserve intensity Moderate intensity Heavy intensity
Reserve posture Attack first day Attack first day
ECrate: 0.5 ECrate: 1 ECrate: 1.5
PC rate: 0.028 PC rate: 0.072 PC rate: 0.072
Moderate intensity
Defence succeeding days
ECrate: 1
PC rate: 0.028
1 E&K Scot | Moderate Intensity High Intensity High Intensity
First day attack First day attack First day attack
ECrate:1 ECrate: 1.5 ECrate: 1.5
PC rate: 0.072 PC rate: 0.072 PC rate: 0.072
Moderate intensity
Defence succeeding days
ECrate:1
PC rate: 0.028
1 R de Mais | Moderate Intensity High Intensity Moderate intensity
First day attack First day attack First day attack
ECrate:1 ECrate: 1.5 ECrate: 1
PC rate: 0.072 PC rate: 0.072 PC rate : 0.072
Moderate Intensity
Defence Succeeding days
ECrate:1
PC rate: 0.028
1ChofO Moderate Intensity High Intensity High Intensity
First day attack First day attack First day attack
ECrate:1 ECrate: 1.5 ECrate: 1.5
PC rate: 0.072 PC rate: 0.072 PC rate: 0.072
Moderate intensity
Succeeding days
ECrate:1
PC rate: 0.028
B Coy Moderate Intensity
R West R Reserve posture

ECrate: 1
PC rate: 0.028




Groupings

13. The next step in the extraction of data is to establish the command and control relationships
between subordinate formations and units. Table 4 displays how the 12 CIB commander delegates

authority to subordinates according to their responsibilities.

Table 4: Task Organisation - 12 CIB

RdeHull |1E&K 1R de Mais | 1CHof O | Others Units Attachments
Scot and
detachments
OPCOM OPCOM OPCOM OPCOM 12 E de Reco OPCOM
two tps 127 | sqn R de pl CoyBR sgn R de 12 CER
Armd Engr | Hull West R Hull coy B R West R
Sqn 122 Fd Sgn | 123 Fd Sqn | 127 Armd | Coy B R West R
Engr Sqn(_) Detach to OPCOM
OPCON OPCON OPCON 1 R de Mais: pl OPCON
BC/FOOs | BC/FOOs | BC/FOOs OPCON 12 Svc Bn
124 Fd Bty | 122 Fd Bty | 123Fd Bty | BC/FOOs | 12 Fd Regt 42 Med Coy
121 Fd Bty | detached to OPCON | aAmb pl 45 Amb
Detach to affiliated units : Coy
OPCOM 1 BC /FOOs
CH of O:
Detached to
OPCOM 1 CH of O:
armd engr sqgn (-)
Detached to
OPCOM 1 E &K
Scot: Fd sgn
Road Move Parameters
14. In order to make a tactical road move, all the itineraries that the 12 CIB units may take need
to be described. These include information on the:
a. Start points;
b. Release points (Rel P): A clearly defined point on a route at which specified

elements of a column (a group of vehicles moving under a single commander) revert
to the command of their respective commanders;

c. Critical points (CP): Selected points along a route where interference with
movement may occur or where timings are critical;

d. Distances between critical points;



e. Road Type;

f. Time spent at the CP, and
0. Order of March: the order in which vehicles and equipment are to be moved.
15. Tables 5 and 6 summarise the information on the 12 CIB road move parameters for two

different itineraries: HEART route and DIAMOND route.

Table 5: Road Move Parameters

Itineraries From to Distance (km) Road Type Time spent at
CP
HEART Route SP CP1 150 Good Road 0:30
HEART Route CP1 CP2 150 Good Road 0:30
HEART Route CP2 Rel P 100 Twisty and Hilly 0:30
DIAMOND Route SP CP1 130 Twisty and Hilly 0:30
DIAMOND Route CP1 Rel P 220 Bad 0:30

Table 6: Order of March

HEART Route

DIAMOND Route

12 E de Reco 1ChofO
1R de Hull Bde HQ & SIG
1 E & K Scot B Coy R West R
1 R de Mais 12 FD Regt
12 CER 12 SVC BN
42 MD Coy
Amb PI




SECTION 3: THE STEP BY STEP GUIDED TOUR

The Binder

16. The EBB Binder is the only entry point of the EBB Suite and must be used to access the
browsers and planners of the Suite.

17. Start the EBB Binder by clicking on the EBB V2.0 or V 2.1 Binder entry of the Electronic
Battle box submenu of the Program Files menu appearing when clicking on the Start button of the
Windows taskbar;

18. Usually, the first thing to do in the Binder is the creation of a new operation.

How to create a new operation
19. Ensure that the Operations tab is active. If not, click on the Operations tab;

a. Click on the New Operation button of the toolbar and wait until the progress

box disappears;

b. Enter the name of the operation, in this case "12 CIB operation™ and press enter. A
new empty operation is created.

«: EBE Binder M=l
e
DOperations | Dacuments |

Doctrinal Equipment =

Doctrinal Friendly Forces
Doctrinal Opposing Forces
2 CIB operation
+]-- 13« TOZEs
Tasks
‘E Logizstic Options
-k Lift Dptions
--ﬁ Foad Myt Options
‘e dm Rl Myt Options
-_l_- Air Mt Options

(=] Callege web
[]--- Mews Operation ;I
| 7
Figure 3: The EBB Binder
The Orbat Browser
20. Once the new operation is created in the Binder, create the Orbat that will be used during the

operation.



How to create the ORBAT of the operation

21. Click on the plus sign beside the 12 CIB operation in the Binder to show its sub-entries.
Start the Orbat Browser by double-clicking on the TO&Es entry of the 12 CIB operation.

22, To create a new Orbat, go to the Orbat Editor since the Orbat Browser can only be used to
view Orbat-related information and not to create some.

a.

Enter the Orbat Editor window by clicking on the "Editor" button of the Main
Toolbar (fourth icon with chart and pencil from the right);

Create a new empty Orbat using the "New" button (organization chart with star) of
the Orbat Editor Main Toolbar. Type the name of the Orbat, in this case "12 CIB",
and click on the Create button. The name of the new empty Orbat appears in the
Editing Orbat field;

23. The next step is selecting the Orbat to copy units from the left part of the Orbat Editor
window. In this case, copy an infantry brigade from the Doctrinal Friendly Forces. To do this:

a. click on the down arrow on the right of the Copy From Operation field,

b. select "Doctrinal Friendly Forces™ in the list,

C. click on the down arrow on the right of the Copy From Orbat field and select the
"Coalition" Orbat.

d. Expand the Coalition unit structure that appears in the left part of the window by
clicking on the plus sign beside Coalition, then CFHQ, LAND, X Allied Corps and
4 Div. Select the infantry brigade (Inf Bde (x2));

e. Copy the infantry brigade in the new Orbat by dragging inf bde of Coalition to the
right part of the window, where the unit structure of 12 CIB Orbat will be displayed.
The "Copy Unit Options" dialog box appears. Choose the options to copy all levels
and to obtain only one instance. Click on OK and wait until inf bde appears in the
right section of the window;

24. Since no artillery, engineers, anti-armoured and combat support elements are included in the

basic 12 CIB Orbat, these will have to be selected them from the doctrinal Friendly Forces Orbat in
the left part of the screen and dragged to the right part of the window. To do this:

a.

Click on the arty bde (x3). Select the Field Regt (x3), drag it to the right part of the
window over the inf bde symbol. The "Copy Unit Options” dialog will appear.
Choose the options to copy all levels and to obtain only one instance. Click on OK
and wait until FIELD REGT appears in the right section of the window.

Click on the engineer group and select CER(x2). Add it to the 12 CIB Orbat by
dragging the icon to the right part of the window over the 12 CIB symbol. When the
"Copy Unit Options™ dialog box appears, choose the options to copy all levels and to
obtain only one instance. Click on OK and wait until CER appears in the right
section of the window.

Click on the A ARMOUR BN, select A-ARMOUR COY (x3) and drag it to the
right section of the window over the 12 CIB symbol. When the "Copy Unit Options"
dialog box will appear, choose the options to copy all levels and to obtain only one

10



instance. Click on OK and wait until A ARMOUR COY appears in the right section
of the window.

d. Click on the DISGP icon, select the SUP BN and drag it to the right part of the
window over the 12 CIB symbol. When the "Copy Unit Options" dialog box
appears, click on OK and wait until SUP BN appears in the right part of the window.

e. Click on the MED BN from the doctrinal Friendly forces in the left part of the
window, select the MED SP COY and drag it to the right part of the window over
the 12 CIB symbol. Click on OK and wait until MED SP COY appears in the right
part of the window. Always under the MED BN symbol, click on AMB COQY, select
AMB PL (x7) and drag it to right part of the window, under the 12 CIB Orbat.
Choose the options to copy all levels and to obtain only one instance. Click on OK
and wait until AMB PL appears in the right part of the window.

25. At the end of the process described above, the EBB Orbat Editor for the 12 CIB operation
should be composed of the following units:

Editing Operation: New Operation

Editing Orbat: |12 CIB =l

=-=] IMF BDE

=@} A ECCE SUN
q-3] ARMD REGT
-] IMF BMH_1

i INF BM_2

-] IMF BH_3

- {m] CER

i-[7] FIELD REGT
q-[7] & ARMOUR COY
i BDE HO & SIGS
i <] SUP EN

i-HH MED SP COY
- AMB PL

=

o OO e OO s O e OO0 IO O s OO IO OO |

Figure 2: The EBB Orbat Editor for the 12 CIB Operation

26. Since the Doctrinal Friendly Forces Orbat is not needed anymore, it is suggested that the left
part of the screen be hidden. This will allow complete concentration on the new Orbat and give it
maximum screen space. To do this:

a. Click on the Show/Hide Unit Outline button, which is the first button of the main
toolbar;

217. Rename the INF BDE to 12 CIB by:

a. right-clicking on INF BDE and selecting the Properties function. Type 12 CIB
instead of INF BDE in the short name field, and click on OK;

11



b. Use the same procedure to rename the 12 CIB units as follows:

Editing Dperation: Mew Operation

Ediling Drbat | 12 CIE =l

== 12018

E-ER 12 E de RECO
-] R de HULL

f-Em) 1 E&K SCOT
f-E=] 1 R de MAIS
q-f=g 1 CH of O

-] 12 CER

f-f=5) 12 FIELD REGT
f-7=] B COY A WEST R
-] BDE HO & SIGS
i-[] 12 SVC BN

i-FH 42 MED COY
4B PL 45 AMB COY
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Figure 5: The 12 CIB Orbat

28. Adjust the actual quantities of personnel and equipment of all units of the Orbat so that they
correspond to 50% of the establishment quantities. To do this, right-click on 12 CIB and select the
Adjust Actual Quantities function. The corresponding dialog box appears. Type 50 in the percent
field, verify that the Establishment Quantity is selected, that all the other boxes are checked, and
click on OK;

29. Usually, after having changed the equipment and personnel quantities of one or more units,
the program should do a recalculation. This computation will verify that all calculated data are
updated and if not, will be updated based on the changes made. To do this:

a. Recalculate the possessions of the edited Orbat by clicking on the "Calculate” button
of the Orbat Editor Main Toolbar. When the computation is completed, a message
appears in the bottom part of the Recalculating Resources dialog box, click on the
Close button;

b. To view the results of the calculations, right click on the 12 CIB symbol and select
the Properties function. If the above steps have been correctly followed, the
personnel quantity should be 7734. After adjustment, the “actual total” will be
3868. Figure 6 displays the details.
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Figure 6: The Personnel Quantity

30. Once done, exit the Orbat Browser by selecting the Exit function of the File menu.

The Task Browser

31. At this point, the Orbat of the operation and actual quantities of personnel and equipment of
each unit have been set. The next step is creating the task plan i.e. defining what the units of the
Orbat have to do in order to complete the operation. It is suggested to plan the required task
hierarchy before actually creating tasks in the Task Browser because some actions are not allowed in
the tool. For example, it is not possible to drag a phase on another phase so that it becomes a

subtask of that phase.
32. In order to create a task plan
a. Start the Task Browser by right-clicking on the Tasks entry of the 12 CIB operation

e.

in the Binder and selecting the Open function.

Adjust the operation time scale by double-clicking on the time ruler just below the
main toolbar.

Set the top scale parameters as follows:

(1) Unit: Days, Increment: 1 and Caption: D+1, D+2...
Set the bottom scale parameters as follows:

1) Unit: Hours, Increment: 6 and Caption: H+1, H+2...

Set the D-Day (at the bottom of the dialog box) to today's date and click on OK.

33. The next steps create the hierarchy of tasks related to the 12 CIB operation. To do this:

a.
b.

C.

Click on the "New Phase" button of the Main Toolbar.
Enter a name for the phase, in this case "12 CIB operation".

Click on the three dots button on the right of the TO&E field.
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34,

35.

36.

37.

d.

e.

Select the 12 CIB Orbat and click on OK.

Click on OK again to close the New Phase dialog box.

Create a task for the road movement under the 12 CIB operation. To do this:

a.

b.

Select the 12 CIB operation by clicking on it.

Click on the New Task button of the Main Toolbar.

Enter a name for the task, in this case "Road move to assy area Thunder Bay".
Click on the three dots button on the right of the Assigned Unit field.

Select the 12 CIB Unit and click on OK.

Click on OK again to close the New Task dialog box.

Create a task to represent phase 1 of the 12 CIB operation. To do this:

a.

b.

Select the 12 CIB operation by clicking on it.

Click on the New Task button of the Main Toolbar.

Enter a name for the task, in this case "Advance to BIG TOP".

Click on the three dots button on the right of the Assigned Unit field.
Select the 12 CIB Unit and click on OK.

Click on OK again to close the New Task dialog box.

Create a task to represent phase 2 of the 12 CIB operation. To do this:

a.

b.

Select the 12 CIB operation by clicking on it.

Click on the New Task button of the Main Toolbar.

Enter a name for the task, in this case "Fix A and seize B1 and B2".
Click on the three dots button on the right of the Assigned Unit field.
Select the 12 CIB Unit and click on OK.

Click on OK again to close the New Task dialog box.

Create a task to represent phase 3 of the 12 CIB operation. To do this:

Select the 12 CIB operation by clicking on it.

Click on the New Task button of the Main Toolbar.

Enter a name for the task, in this case "Seize A and C1 and C2".
Click on the three dots button on the right of the Assigned Unit field.
Select the 12 CIB Unit and click on OK.
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38.

39.

40.

41,

f.

Click on OK again to close the New Task dialog box.

Create a task for the air movement under the 12 CIB operation. To do this:

a.

b.

Select the 12 CIB operation by clicking on it.

Click on the New Task button of the Main Toolbar.

Enter a name for the task, in this case "Air move to BERLIN".

Click on the three dots button on the right of the Assigned Unit field.
Select the 12 CIB Unit and click on OK.

Click on OK again to close the New Task dialog box.

Create a task under phase 1 of the 12 CIB Operation. To do this:

a.

b.

Select the phase by clicking on it.

Click on the New Task button of the Main Toolbar.

Enter a name for the task, in this case "Screen forward of the bde adv to BIG TOP".
Click on the three dots button on the right of the Assigned Unit field.

Select the 12 E de Reco under the 12 CIB Unit and click on OK.

Click on OK again to close the New Task dialog box.

Create a task under phase 2 of 12 CIB operation. To do this:

Select the phase by clicking on it.
Click on the New Task button of the Main Toolbar.

Enter a name for the task, in this case "Attempt to screen the RIGHT flank from
BIG TOP to BILLY BOB".

Click on the three dots button on the right of the Assigned Unit field.
Select the 12 E de Reco unit and click on OK.

Click on OK again to close the New Task dialog box.

Create a task under phase 3 of 12 CIB operation. To do this:

a.

b.

Select the phase by clicking on it.
Click on the New Task button of the Main Toolbar.

Enter a name for the task, in this case "Attempt to screen the RIGHT flank from
BIG TOP to BILLY BOB".

Click on the three dots button on the right of the Assigned Unit field.
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e. Select the 12 E de Reco Unit and click on OK.
f. Click on OK again to close to New task dialog box.

42, Apply the same procedure to create the others tasks under phase 1, phase 2 and phase 3. Be
careful to assign the right unit to the right task. At the end, if everything goes well, The window
should look exactly as follows:

E.E;::EBB Taszk Browser - 12 CIB operation

File Edt “iew Toolz Help
¥

Task View

E"E 12 CIB operation

Foad move to azsy area THUMDER BAY
=T Advance to BIG TOP

Screen fonward of the brigade advance

Reserve

Advance CEMTRE forward

Advance LEFT forward

Advance RIGHT fomnward

LEFT flank security throughout

=1-{T Fir &4 and Seize B1 and B2

Scresn the RIGHT flank from BIG TOF ta BILLY BOB
T Advance to BIG TOP

[T Seize OB B1

zeize en in Obj A

Frovide one inf coy az bde reserve until phase 3
[T Seize OB B2

=T Seize A and C1 and C2

Screen farward of highweay 8434

On order zeize Obj C1

Conzolidate along highway 5./94

T ssize Obj &

[T Cnsnlidate alnnn Hinkweay 8498

Figure 7: The Task Browser

43. The next steps are for setting the timings of each task. Always begin with the tasks that
don't have any subtasks since these timings will impact those of the higher level tasks:

a. First verify that the "Snap task to scale” option is checked in the Tools/Options
menu.
b. Set the timings for the Road move to assy area THUNDER BAY task so that it ends

at D Day, H+0 and lasts 24 hours. To do this:
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1) drag the bar (on the Gantt chart) of the road move to assy area THUNDER
BAY task so that it ends at the D+0, H+0;

2 place the mouse cursor over the beginning of the bar (a left arrow appears);
and

3) Drag and drop the beginning of this bar close to H-24 tick of the ruler
appearing at the top of the Gantt chart.

Set the timings for phase 1 "Advance to BIG TOP" so that it begins at D+0, H+0
and lasts 24 hours. To do this:

1) place the mouse cursor over the end of the bar that represents the "Advance
to BIG TOP" (a right arrow appears),

(2 drag and drop the end of this bar close to the H+24 tick of the ruler
appearing at the top of the Gantt chart;

Set the timings for phase 2 "Fix A and seize B1 and B2" so that it begins at D+1,
H+24 and lasts 72 hours. To do this:

Q) place the mouse over the bar (on the Gantt chart) that represents the phase
task (a rectangle with two arrows appears);

2 drag and drop the whole bar so that its beginning is aligned with the D+1,
H+24 tick of the ruler appearing at the top of the Gantt chart;

3) place the mouse cursor over the end of the bar (on the Gantt chart) that
represents the "screen the RIGHT flank from BIG TOP to BILLY BOB"
task of phase 2 (a right arrow appears);

4 drag and drop the end of this bar close to the D+3, H+96 tick of the ruler
appearing at the top of the Gantt chart;

(5) Do the same thing with all the other tasks of phase 2.

In order to resolve the conflict (represented by the red colour) between the tasks
"seize en in Obj A" and "provide one inf coy as bde reserve until phase 3",

(1) place the mouse cursor over the end of the bar (on the Gantt chart) that
represents the "seize en in Obj A" task (a right arrow appears);

2 drag and drop the end of this bar close to D+2, H+60 tick of the ruler
appearing at the top of the Gantt chart;

3) place the mouse cursor over the beginning of the bar that represents the
"provide one inf coy as bde reserve until phase 3" task (a left arrow
appears);

4) Drag and drop the beginning of this bar close to D+2, H+60 tick of the ruler
appearing at the top of the Gantt chart.

Set the timings for phase 3 "Seize A, C1 and C2" so that it begins at D+4, H+96 and
ends 72 hours later. To do this:
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(1)

(@)

3)

(4)

Q)

place the mouse over the bar (on the Gantt chart) that represents the phase
task (a rectangle with two arrows appears);

drag and drop the whole bar so that its beginning is aligned with the D+4,
H+96 tick of the ruler appearing at the top of the Gantt chart;

place the mouse cursor over the end of the bar (on the Gantt chart) that
represents the first task of phase 3 (a right arrow appears);

drag and drop the end of this bar close to the D+7, H+168 tick of the ruler
appearing at the top of the Gantt chart;

do the same thing with all the other tasks of phase 3

In order to solve the conflict (represented by the red colour) between the tasks "On
order seize C1" and "Consolidate along highway 8/9A"

(1)

()

(3)

(4)

place the mouse cursor over the end of the bar (on the Gantt chart) that
represents the "On order seize Obj C1" task (a right arrow appears);

drag and drop the end of this bar close to D+5, H+120 tick of the ruler
appearing at the top of the Gantt chart;

place the mouse cursor over the beginning of the bar that represents the
"Consolidate along highway 8/9A" task (a left arrow appears);

Drag and drop the beginning of this bar close to D+5, H+120 tick of the
ruler appearing at the top of the Gantt chart.

Apply the above procedure (g) to all the other pairs of tasks that present a conflict,
due to the fact that a unit is tasked to accomplish two tasks at the same time. A
definition for every task-related conflict encountered may be obtained by right-
clicking and selecting the conflicts function.

Finally, set the timings for phase 4 so that it begins at D+7, H+168 and ends 12
hours later. To do this:

(1)

()
3)

drag the bar (on the Gantt chart) of the air move to BERLIN task so that it
begins at D+7, H+168 and lasts 12 hours;

place the mouse cursor over the end of the bar (a right arrow appears);

Drag and drop the end of this bar close to H+180 tick of the ruler appearing
at the top of the Gantt chart.

44, At the end of the process, if everything goes well, the 12 CIB task chart should look exactly

as follows:
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Figure 8: The Task Chart of the 12 CIB Operation

45, The next steps are used to create the required parameter sets. Based on the 12 CIB concept
of operation, five different parameter sets are required. One of these is the Reserve parameter set.
Let's say that, by default, the units are in reserve. In the Task Browser, all tasks are assigned the
Default Parameter Set, thus rename the Default Parameter Set to Reserve in order to assign a reserve
parameter set to all tasks. To do this:

a. Open the Parameter Set dialog box by clicking on the Tools/Parameter Set menu.
b. Select the Default Parameter Set by clicking on it in the left part of the dialog box.
C. Click on the Modify button.
d. Change the name of the parameter set to "Reserve".
e. Set the intensity to Reserve by clicking on the down arrow on the right of the
Intensity field and selecting Reserve in the list.
f. Set the equipment combat rate to 0.5.
g. Set the personnel casualty rate to 0.028.
h. Set the IMP ration factor to 1.
i. Click on the Accept button.
46. Another parameter set is required for 12 E de Reco. To create this parameter set:
a. Click on the New button.
b. Enter the name of the parameter set, let's say "SCREEN".
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C. Set the intensity to moderate.

d. Set the posture to reserve.

e. Set the Equipment Combat Factor to 1.

f. Set the Personnel Casualty Factor to 0.072.

g. Set the IMP ration factor to 1.

h. Click on the Accept button.
47, Another parameter set is required to represent the advance of the units. To create this
parameter set:

a. Click on the New button.

b. Enter the name of the parameter set, let's say "ADVANCE".

c. Set the intensity to moderate.

d. Set the posture to Attack First Day.

e. Set the Equipment Combat Factor to 1.

f. Set the Personnel Casualty Factor to 0.072.

g. Set the IMP ration factor to 1.

h. Click on the Accept button.
48. Another parameter set is required for the units when they are fixing the enemy or seizing an
objective. To create that parameter set

a. Click on the New button.

b. Enter the name of the parameter set, let's say "FIX and SEIZE".

C. Set the intensity to heavy.

d. Set the posture to Attack First Day.

e. Set the Equipment Combat Factor to 1.5.

f. Set the Personnel Casualty Factor to 0.072.

g. Set the IMP ration factor to 1.

h. Click on the Accept button.
49, The next steps are for assigning the correct parameter set to the different tasks. Remember

that all phases and tasks have, by default, the Reserve parameter set. Thus, only the tasks that need
to have a different parameter set must be modified.

50. Assign the appropriate parameter set to the “Screen forward of the bde adv to BIG TOP”
task during phase 1. To do this:
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a. Right-click on the “Screen forward of the bde adv to BIG TOP” task.

b. Select the Properties function.
C. Click on the down arrow on the right of the Parameter Set field.
d. Select SCREEN in the list.
e. Click on the OK button.
51. Assign the appropriate parameter set to the Reserve task of phase 1. To do this:
a. Right-click on the Reserve task.
b. Select the Properties function.
c. Click on the down arrow on the right of the Parameter Set field.
d. Select Reserve in the list.
e. Click on the OK button.

52. Assign the appropriate parameter set to the “Advance CENTRE forward” task of phase 1.
To do this:

a. Right-click on the task.

b. Select the Properties function.

C. Click on the down arrow on the right of the Parameter Set field.
d. Select Advance in the list.

e. Click on the OK button.

53. Assign the appropriate parameter set to the “Seize Obj B1” task of phase 2. To do this:

a. Right-click on the task.

b. Select the Properties function.

c. Click on the down arrow on the right of the Parameter Set field.
d. Select FIX and SEIZE in the list.

e. Click on the OK button.

54, Assign the appropriate parameter set to the “Consolidate along highway 8/9A” task of phase
3. Todo this:

a. Right-click on the task.
b. Select the Properties function.
c. Click on the down arrow on the right of the Parameter Set field.
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d. Select Consolidate in the list.

e. Click on the OK button.

55. Another important process of the Task Browser is creating attachment Groupings. To do
this:

a. Right-click on the 12 CIB Operation phase.

b. Select the Groupings function in the contextual menu.

c. Set the number of level down to one by clicking once on the down arrow on the
right of the Level Down field appearing at the top of the window.

d. Drag the sgn R de Hull symbol and drop it over the 1 E &K Scot symbol. The
Attach Information dialog box appears.

(1) Set the command relationship to operational command by clicking on the
down arrow and selecting the corresponding item of the list. As well, set
the Administrative Relationship to For Administration.

(2 Click on OK. The attachment is done.

e. Check the Show Detachments box at the top of the window to see that one sgn is
effectively detached from R de Hull. Double-click on the 1 E &K Scot symbol to
see that one sgn of R de Hull is attached to it.

f. Repeat the previous procedure to set up the groupings as indicated in table 4 in
section 2.

g. Once finished Click on the Close button to quit the Groupings Definition window.

56. Notice that the work is never saved. In fact, every tool of the EBB Suite has a built-in

automatic save function.

57. Every thing that needed to be done with the Task Browser has been completed. Quit the
Task Browser using the X appearing at the top right corner of the browser window. The next step is
creating logistics options.

Logistics Options

58. For the purpose of this example, suppose an estimate of the quantities of supply required by
all units involved in the 12 CIB operation is required. To do this:
a. Start the Logistic Planner by right-clicking on the Logistic options entry of the 12
CIB operation in the Binder and selecting the Open function.
b. Select "Create a new option" in the dialog box and click OK.
c. Follow the steps of the wizard. First enter a name for the option about to be created.

In this example, type "Supplies — 12 CIB operation™. Click on the Next button.
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d. The hierarchy of all the tasks of the operation appears on the left. Click on the plus
sign to see the subtasks of the 12 CIB operation. Since an estimate of the quantities
of supply to all units involved in the 12 CIB operation is required, select the whole
organisation.

e. Click on the 12 CIB task and then on the right arrow appearing in the middle area of
the wizard window. The 12 CIB operation is then copied in the right section. Click
on the Next button.

f. The upper left section of the wizard window displays the task selected in the
previous step. Select 12 CIB in the lower left section and click on the right arrow
appearing in the middle area. 12 CIB appears in the right section. Click on the Next

button.
0. There is no need to change the weight per pallet. Click on the Next button.
h. Read the message and click on the Finish button.
59. If the steps of the Logistic Planner wizard have been followed correctly, a logistic option

with the following characteristics should be obtained.

w EBB rodizpc plovwel - |5 CIg eberapow - pnbbpez - |5 CIp obsiopou

Figure 9: The 12 CIB Loaqistics options

60. Now look at the different calculated weight of supply. There may be a need to adjust some
of the calculated weight.

61. Suppose there is a need for more DSL (500 kg) for the M113 PERS. To do this:
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a. Click on the Petrol, Oil, Lubricant tab.

b. In the grid of the view by vehicle, click on the additional weight cell of the M113
PERS vehicle.
c. Enter 500 and press the up arrow.

62. Note there are different types of reports that may be printed. To do this:

a. Click on the Print button of the main toolbar.
b. Note the three types of reports available.
c. Click on the Cancel button of the dialog box.
63. Exit the Logistic Planner by selecting the Exit function of the File menu;

The lift Planner

64. Usually, after having calculated a logistic option, one may want to know the number of
vehicles required to transport these supplies. To do this, create a lift option with the Lift Planner.

a. Start the Lift Planner by right-clicking on the Lift options entry of the 12 CIB
operation in the Binder and selecting the Open function.

b. Select "Create a new option™ in the dialog box and click OK.

C. Follow the steps of the wizard. First enter a name for the option about to be created.

In this example, type "Lift of supplies”. Click on the Next button.
65. The task that must be selected in the wizard is the 12 CIB operation. To select this task:

a. Click on the 12 CIB operation task and then, Click on the right arrow appearing in
the middle area of the wizard window. The 12 CIB operation is then copied in the
right section. Click on the Next button.

b. The upper left section of the wizard window displays the task selected in the
previous step. Click on 12 CIB icon in the lower left section and then click on the
right arrow appearing in the middle area. Thel2 CIB icon appears in the right
section. Click on the Next button.

C. Select only the supplies to transport and the type of road that will be used for the
transportation. In this example, transport all classes of supplies on road. Click on
the Next button.

d. Select the logistic option in which the quantities of supply to transport are
calculated. Since only one logistic option was created, it is already selected. Click
on the Next button.
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e. Read the message and click on the Finish button. If the steps of the Lift Planner
wizard have been correctly followed, the following lift option results.
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Figure 10: The Lift of Supplies — 12 CIB Operation

66. The Lift Planner provides a lot of information, like the required number of vehicle to
transport all supplies or specific types of supply, the capacity of these vehicles, the surplus or lack of
vehicles and pallets, etc. As well, one can specify the quantity of vehicles that will actually be used
for the transportation of supplies.

67. Adjust the quantity of equipment assigned to the transportation of supplies so that the
surplus of available equipment is minimal (but not negative). To do this:

a. Click on the Vehicles tab.
b. Click on a cell of the Equipment Currently Assigned column.
C. Enter a new number of equipment and look at the impact on the surplus/lack

information to see if it needs to be adjusted again.
d. As needed, change all the assigned quantity of equipment.

68. As a result, the Surplus/Lack section appearing on the right of the Vehicles tab should
display positive but minimal quantities, meaning that there is still a little room to load supplies on
the vehicles.

69. Exit the Lift Planner by selecting the Exit function of the File menu.

Road Movement Planner

70. There are two reasons to use the Road Movement Planner:
a. To have a detailed schedule for a dumping plan or to move troops by road.
b. In the 12 CIB example, consider a tactical road move.
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How to make a road movement option

71. Start the Road Movement Planner by right-clicking on the Road Mvt options entry of the 12
CIB operation in the Binder and selecting the Open function.

a. Select "Create a new option™ in the dialog box and click OK.

b. Follow the steps of the wizard. First enter a name for the option about to be created.
In this example, type "Road move to assy area THUNDER BAY™. Click on the
Next button.

C. The task that must be selected in the wizard of the Road Movement Planner is the
task during which the road move is done. In the example, it's during the Road Move
to assy area THUNDER BAY. To select this task:

d. Click on the plus sign to see the subtasks of 12 CIB Operation.

e. Select the Road Move to assy area THUNDER BAY task.

f. Click on the right arrow appearing in the middle area of the wizard window. The
Road Move to assy area THUNDER BAY task is then copied in the right section.
Click on the Next button.

g. The upper left section of the wizard window displays the task selected in the
previous step. Click on the plus sign appearing left to 12 CIB in the lower left
section.

72. The units appearing in the Order of March are those selected at this step of the wizard.

Thus, based on the Concept of Op, select the reconnaissance, manoeuvre, combat support and
service support units

a.

To do this:
1) Click on 12 E de Reco in the lower left section.
(2 Click on the right arrow appearing in the middle area.

3 Do the same for all the units, in accordance with the order of march as
stated in section 2.

(4) Click on the Next button.

Step 4 of the wizard presents default values for various road movements planning
information. Those values may be kept, but let's change the Distance between
vehicles at night to 150m. To do this:

1) Click on the corresponding field.
(2 Enter 150.
3 Click on the Next button.

Read the message and click on the Finish button. All the steps of the Road
Movement Planner wizard have now been completed.
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73. In the Road Movement Planner, there is still a lot of information that needs to be specified in
the different tabs before obtaining the detailed road movement schedule. The next 3 steps are for
specifying the information required in the Movement Information tab.

a. Select the movement type. In this case, it's a road move (not a dumping).

b. Select the duration type. Use the Zulu time. The starting date is set to the beginning
of the Road Move to assy area THUNDER BAY task.

c. Choose the road movement period. No constraints were specified for the road
move. Thus, set the period for Night and Day. There is no need to specify the day
light period.

74. The next steps are for specifying the information required in the Road Definition tab. It is

important to make the difference between the roads and the itineraries. In this tab, specify the roads
as they are defined in the 12 CIB concept of Op.

a. Go to the Road Definition tab by clicking on it.

b. Click on the New button appearing in the upper section of the window to create a
new road. A New Road dialog box appears. "Road 1" is already written in the field.
Click on the OK button.

75. Now, specify the road segments composing Road 1:
a. Create the first segment of Road 1. To do this:

1) Click on the New button appearing in the lower section of the window to
create a new road segment. A New Segment dialog box appears. The name
of the critical points defining the road segment cannot be changed.

2 Use the mouse to put the mouse cursor on the Distance field.

3) Erase the current value and enter the distance, in this case, 150 km.
4) Press the Tab key once on the keyboard to go to the road type field.
(5) The currently set road type is the correct one.

(6) Press the Tab key once on the keyboard to go to the Time spent field, enter
"00:30".

(7 Click on the OK button.

b. Create the second segment of Road 1. Follow exactly the same procedure as the
preceding one.

76. Create the last segment of Road 1. To do this:

1) Click on the New button appearing in the lower section of the window to
create a new road segment. A New Segment dialog box appears.

2 Use the mouse to put the mouse cursor on the Distance field.

3) Erase the current value and enter the distance, in this case, 100 km.
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(4)

Press the Tab key once on the keyboard to go to the road type field.

(5) Press twice on the down arrow key to select Twisty and Hilly Roads.
(6) Press the Tab key once on the keyboard to go to the Time spent field.
(7 Enter "00:30".
(8) Click on the OK button.
77. Road 1 and its segments have been created. Now, specify the second road used for the road

movement. To do this:

a.

Click on the New button appearing in the upper section of the window to create a
new road. A New Road dialog box appears. "Road 2" is already written in the field.
Click on the OK button.

Notice that the lower section of the window doesn't display the segments of road 1
anymore. Now, specify the road segments composing Road 2.

Create the first segment of Road 2. To do this:

(1)

()
3)
(4)
()
(6)
()
(8)

Click on the New button appearing in the lower section of the window to
create a new road segment. A New Segment dialog box appears.

Use the mouse to put the mouse cursor in the Distance field.

Erase the current value and enter the distance, in this case, 130 km.
Press the Tab key once on the keyboard to go to the road type field.
The currently set road type is the correct one (Twisty and Hilly Roads).
Press the Tab key once on the keyboard to go to the Time spent field.
Enter "00:30".

Click on the OK button.

Create the other segment of Road 2. To do this:

(1)

()
3)
(4)
()
(6)
(7)

Click on the New button appearing in the lower section of the window to
create a new road segment. A New Segment dialog box appears.

Use the mouse to put the mouse cursor in the Distance field.

Erase the current value and enter the distance, in this case, 220 km.
Press the Tab key once on the keyboard to go to the road type field.
Click on the down arrow on the right of the road type field.

Select Bad Road in the list.

Press the Tab key once on the keyboard to go to the Time spent field.
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(8) Enter "00:30".
9) Click on the OK button.

78. The roads used by the road movement are now specified. Click on the Mobility tab. In this
example, don’t change the default maximum speed values;

79. The next steps are for specifying the information required in the Itinerary Definition tab. In
our example, it's a coincidence that the two itineraries correspond to two roads. However, the
itineraries need to be specified.

a. Click on the Itinerary Definition tab.

b. Create a new itinerary by clicking on the New button appearing in the upper right
section of the tab. A New Itinerary dialog box appears. "ltinerary 1" is already
written in the field. Type HEART Route. Click on the OK button.

80. Now, define which segments of road are used in the Itinerary 1. In this case, Road 1 is used
from SP to RelP.

a. Select the road:

1) Click on the down arrow on the right of the Available roads field (upper left
section of the tab).

(2 Select Road 1 in the list.
b. Select the road segments:

Q) Click on the down arrow on the right of the From field (Road Segments
section).

2 Select SP in the list.

3 Click on the down arrow on the right of the To field (Road Segments
section).

4 Select RelP in the list.

C. Click on the right arrow appearing in the middle area of the tab. The selected road
segment is added to the itinerary.

81. The HEART route and associated segments have been created. Now, specify the second
itinerary used for the road movement. To do this:

a. Click on the New button appearing in the upper right section of the tab to create a
new itinerary. A New lItinerary dialog box appears. "ltinerary 2" is already written
in the field. Click on the OK button.

b. Notice that the lower right section doesn't display the segments associated with
itinerary 1 anymore. Now, specify the road segments associated with Itinerary 2.

C. Select the road:
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1) Click on the down arrow on the right of the Available roads field (upper left
section of the tab).

2 Select Road 2 in the list.

d. Select the road segments:
1) Click on the down arrow on the right of the From field (Road Segments
section).
2 Select SP in the list.
3) Click on the down arrow on the right of the To field (Road Segments
section).
4) Select RelP in the list.
e. Click on the right arrow appearing in the middle area of the tab. The selected road
segment is added to the itinerary.
82. The itineraries are now defined. Before triggering the road movement calculation, there is

one step left. Specify the order of march of each itinerary.

a.

b.

Click on the Order of March tab.
Select the itinerary:

Q) Click on Click on the down arrow on the right of the Selected Itinerary field
(upper right section of the tab).

(2 Select HEART Route in the list.
Click on the Modify button appearing at the bottom of the tab

Add the units to the order of march as indicated in the 12 CIB concept of Operation.
To do this:

Q) Select 12 E de Reco in the list on available units (left section).
2 Click on the single right arrow appearing in the middle area of the tab.

3) Apply the same procedure to add the other units to the order of march on
HEART route as indicated in the 12 CIB concept of operation (see table 6 in
section 2).

Order the selected units so that it corresponds to the exact order of march. To do
this:

1) Click on the element to order in the right section (Itinerary order of march).
2 Click on Modify.

3) Click on the down or up arrow (appearing on the right) until the element is
at the right place.
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(@) Click on the Accept Change button to indicate that this itinerary order of
march is finished.

f. Repeat sub-paragraph b, ¢, d and e for DIAMOND route.

83. Once all required information has been specified, click on the Calculate button or trigger the
corresponding function from the Tools menu. A Road Movement Calculation dialog box appears to
choose the itinerary to create a road movement table.

a. In the dialog box:
1) Select HEART route.

2 Click on the Calculate Now button. The content of the Road Movement
Table tab is displayed after the calculation, presenting the schedule for
HEART route as follows.

EBB Road Movement Planner - 12 CIB operation - Road Mowve to Azsy Area THUNDER BAY
=] ?.

150 5 5 o v A W

Figure 11: Road Move to Assembly Area Thunder Bay — HEART Route

31



b. Repeat sub-paragraph a to display the schedule for DIAMOND route.

EEBB FRoad Movement Planner - 12 CIB operation - Road Move to Aszy Area THUNDER BAY

=== =

0 5 o e o o o U A A

Figure 12: Road Move to Assembly Area Thunder Bay — DIAMOND Route

84. Exit the Road Movement Planner by selecting the Exit function of the File menu.
The Air Movement Planner

85. The Air Movement Planner can help estimate the number of aircraft required for the
transportation of personnel, equipment and/or supplies. In the context of the 12 CIB operation,
suppose that only the personnel and the equipment need to be air transported to BERLIN.

86. Start the Air Movement Planner by right-clicking on the Air Mvt options entry of the 12 CIB
operation in the Binder and selecting the Open function.

a. Select "Create a new option" in the dialog box and click OK.

b. Follow the steps of the wizard. First enter a name for the option about to be created.
In this example, type "Air Move to BERLIN". Click on the Next button.

87. The task that must be selected in the wizard of the Air Movement Planner is the task during
which the air move is done. In the example provided, it occurs during the Air Move to BERLIN. To
select this task:

a. Click on the plus sign to see the subtasks of 12 CIB Operation and then, select the
Air Move to BERLIN task.

b. Click on the right arrow appearing in the middle area of the wizard window. The
Air Move to BERLIN task is then copied in the right section. Click on the Next
button.
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C. Select 12 CIB in the lower left section and click on the right arrow appearing in the
middle area. 12CIB appears in the right section. Click on the Next button.

d. Read the message and click on the Finish button. The Air Movement Planner
window appears.
88. Now, specify the desired parameters for the calculation. In the 12 CIB operation, indicate
that the personnel of the 12 CIB will be moved in Hercules aircraft. To specify this:
a. Check the "Include Personnel" box.
b. Click on the down arrow on the right of the aircraft field.
C. Select Hercules in the list (the number of passengers is automatically set).

89. In the 12 CIB operation, also indicate that the equipment of 12 CIB will be loaded in C-17A
aircraft. To specify this:

a. Check the "Include Equipment” box.
b. Click on the down arrow on the right of the aircraft field.
c. Select C-17A in the list (the payload is automatically set).
90. Click on the Calculate button or trigger the corresponding function from the Tools menu.

Figure 13 displays the content of the Results tab after the calculations.

EBE Air Movement Planner - 12 CIB operation - Air move to BERLIN [ _ O] =]

Figure 13: 12 CIB Operation — Air Move to BERLIN

91. Exit the Air Movement Planner by selecting the Exit function of the File menu.
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The Rail Movement Planner

92. Even though the Rail Movement Planner is the last tool of the guided tour, it can be used as
soon as the Orbat of the operation is defined and equipment is assigned to its units. Note that this
planner only considers the equipment of the units for the rail move. This means that, in the Rail
Movement Planner, movement of personnel and supplies by rail cannot be specified.

93. Start the Rail Movement Planner by right-clicking on the Rail Mvt options entry of the 12
CIB operation in the Binder and selecting the Open function.

a. Select "Create a new option" in the dialog box and click OK.

b. Follow the steps of the wizard. First enter a name for the option about to be created.
In this example, type "Equipment Rail Move". Click on the Next button.

c. Select which Orbat of the operation to use. In this case, only one Orbat is created
for the 12 CIB operation and it is already selected. Click on the Next button.

94, Select the units of the Orbat for which the equipment is to be transported. In this case, make
an option for all the units of 12 CIB:

a. Click on the 12 CIB icon.
b. Click on the right arrow appearing in the middle area of the wizard.
C. Click on the Next button.
95. The step 4 of the Rail Movement Planner Wizard is used to select the equipment that will be

transported by train:

a. The equipment of the 12 CIB appears in the lower left section. Select the first
equipment and click on the right arrow to select all the equipment.

96. Because the type and quantity of train cars that are available for the rail move are not known
yet, select all types of train cars that could be used. Suppose the following types of train cars could
be used: box, container, flat, piggyback, bulkhead, automobile and depressed flat car.

97. To select the desired train cars:

a. Click on the Box car entry in the list of available train car types on the left of the
wizard window.

b. Click on the right arrow appearing in the middle area of the wizard window to select
the Box train car type.

C. Repeat these steps to select the container, flat, piggyback, bulkhead, automobile and
depressed flat car.

d. Check the "Maximise train car loading" box. This will allow the Rail Movement
Planner to put the equipment of more than one unit on a single train car. Note that
the tool will never mix the equipment of different units.

98. Read the message and click on the Finish button. The Rail Movement Planner window
appears.
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99. The first thing to do in the Rail Movement Planner is to set the weight of the three criteria of
the Fitness criteria tab. Setting the weight of the criteria to 4 for the first, 10 for the second and 1 for
the third has proven to be a good combination to have a first evaluation of the required number of
train cars. To set the criteria as suggested:

a. Click on the Fitness Criteria tab.

b. Set the Total Wasted Space criterion to 4 by dragging the indicator onto the fifth
scale.

C. Set the Number of Equipment Left criterion to 10 by dragging the indicator onto the
last scale.

d. Set the Number of Train Car Used criterion to 1 by dragging the indicator onto the

second scale.

100.  All the parameters required by the planner have now been set for the calculation. To start
the calculation of possible train car loading:

a. Click on the Optimisation tab.

b. Click on the Start Calculation button appearing at the top of the tab. A dialog box
appears. Don't click on the Stop button.

101.  Once the calculation is completed, the first row of the grid presents the best option regarding
the desired criteria as follows.

102.  Look at the first train car loading. To do this:

a. Move the mouse cursor over the corresponding cell (car #1 column and first option
row) and wait a few seconds. A little box appears indicating the type of the train car
as well as the equipment loaded on it. It disappears a few seconds later.
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103.
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105.

Figure 14: Equipment Rail Move

Look at the quantity of each type of train car used in the second option. To do this:
a. Select the second option by clicking on any cell of the second option row.

b. Click on the Used Train Cars button appearing at the bottom of the window. A
dialog appears presenting the desired information.

c. Click on the Close button of the dialog box.
To know specifically how many equipment of different types are loaded or not on the train:
a. Select the first option by clicking on any cell of the first option row.

b. Click on the Equipment Load button appearing at the bottom of the window. A
dialog appears presenting the desired information.

c. click on the Close button of the dialog box.

Exit the Rail Movement Planner by selecting the Exit function of the File menu.
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CONCLUSION

106.  The Electronic Battle Box (EBB Suite v 2.1) is a powerful tool used to generate logistics
data. It provides the user with the possibility of creating data in accordance with the specific
requirements of any tactical operation. Using only some extracts of an operation order, one can
define within the EBB browsers the units involved in the operation, as well as the tasks and the
combat parameters related to the operation. The planner tools are then used to generate various data
based on the information specified in the browsers. The EBB Logistic Planner calculates the supply
needs for the selected units to accomplish a specific task, as well as the number of pallets required
for the transportation of supplies. The EBB Lift Planner calculates the number of vehicles required
for handling the supplies. The Road Movement Planner provides the user with a detailed road
movement (or dumping plan) scheduled in the form of a road movement table. The Air Movement
Planner calculates the number of aircraft required for the transportation of the personnel, equipment
and/or supplies. Finally, the Rail Movement Planner provides solutions about how to load a train
depending on the number and type of train cars available, the equipment to load and other fitness
criteria.
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ANNEX A- OPERATION ORDER

Copy Number of

Main HQ 12 CIB

REINBSBURG US 856 533
April 00

OPS 04

OPERATION ORDER 01

References: A: Germany, Series M745 Sheets L4746, L4748, L4750, L4946, L4948, L4950, L5146,
L5148 and L5150, 1:50 000

B. Warning order 03 162022Z April 00

C. 4 Div Operation Order 26 161715Z April 00

Time Zone: ZULU

1. SITUATION

a.

Enemy Forces. 35 MRD assessed to be ceasing its crossing attempts in near future.
35 MRD will likely adopt a defensive posture to protect the south flank of 1 TA. It
is further assessed that 35 MRD will be used to delay and block friendly forces
advances to allow sufficient time for defences in NORTH to be finished and allow
time for committal of reserve forces. 35 MRD expected to be developing
SCHWARZE ELSTER as major obstacle.

I TA confirmed moving area BERLIN UU 9020. 1 TA will likely adopt a defensive
posture on main approaches to BERLIN. 1 TA defensive preparations will not be
completed for 48 hrs.

Enemy air forces retain a limited capability to conduct offensive air operations.
Army Group West has retained the ability to launch airmobile operations and may
conduct heliborne assaults in our depth to disrupt our advance. The enemy has a
good NBC capability, but is not expected to use NBC weapons in this delay, battle.

Friendly Forces.

(1)

(2)

(Comd X Allied Corps Intent. Corps Comd's intent is to seize the NORTH
and SOUTH approaches to BERLIN with three divs.

Comd 4 Div Intent and Concept of Ops. The Div Comd’s intent is to
advance as rapidly as possible and seize Objective MEAT to allow follow-
on forces to seize their objectives. He will accomplish this by advancing
along two axes with 13 CAB LEFT forward and 12 CIB RIGHT forward;
PLDG will screen the advance. Lead bdes may bypass enemy up to coy
strength for destruction by follow-on bdes. The Div Comd’s main effort will
be the seizure of the E30/E55/A1 and E36/E55/A4 Autobahn intersections
VT 0198. His endstate will see the two lead bdes established in hasty
defensive positions WEST and EAST of the Autobahn junction. Follow-on
bdes will secure depth positions
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which will be utilized as assembly areas for the follow-on divs. The
E30/E55/A1 Autobahn will serve as a line of departure for the follow-on
divs.

3) Air. Allocated to the bde are four immediate offensive air support sorties
(OAS) daily commencing 0001 hrs 17 May and one tactical air
reconnaissance (TAR) sortie daily commencing 0001 hrs 17 May.

2. MISSION

12 CIB attacks 170600Z April 00 to seize objective HAMMER, On order attack to seize
Objective LAMB in order to set the conditions for 25 AD and 52 ID to seize EAST approaches to

BERLIN.
3. EXECUTION
a. Concept of Operations. 12 CIB will rapidly advance to BIG TOP three up with I R
de Mais LEFT, | E&K Scot CENTRE and 1 CH of O RIGHT and R de Hull minus
in DEPTH. Recce Sqn will screen forward and confirm crossing sites and gaps.
Anti-armour coy will assist in flank security. The brigade main effort in sequence is
to seize objectives B 1 and B2 then C. The brigade endstate is to consolidate on
Highway 8(9) A facing NORTH prepared to recommence the advance NORTH
towards BERLIN. This will be a three phase operation:
(1) Advance to BIG TOP
2 Fix A and seize B 1 and B2
3) Seize Aand C 1 and C2
b. 12 E de Reco
Q) Tasks.
@ Screen forward of the bde adv to BIG TOP and estb en posns and
possible crossing sites.
(b) Attempt to screen the RIGHT flank from BIG TOP to BILLY BOB
(©) Screen forward of Highway 8/9A in preparation for the bde adv to
Obj LAMB.
C. R de Hull.
@ Grouping.
@ OPCOM 2 tp 127 Armd Engr Sgn
(b) OPCON BC/FOOs 124 Fd Bty
(© Detached to OPCOM Sgn 1 E&K Scot

Sgn 1 CHof O
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(2)  Tasks.
@ Reserve
(b) Adv to BIG TOP and estb a waiting area in the area of GR 2601
(© On order seize Obj C 1

(d) Consolidate along Highway 8/9A and be prepared to continue the
adv to Obj LAMB.

1 E&K Scot.
1) Grouping.
@ OPCOM Sgn R de Hull
122 Fd Sgn
()  OPCON BC/FOOs 122 Fd Bty
(2)  Tasks.

@ Advance CENTRE forward.
(b) Seize Obj B1
(© Seize Obj A

(d) Consolidate along Highway 8/9A and be prepared to continue the
adv to Obj LAMB.

1 R de Mais.
@ Grouping.
@ OPCOM PI R West R
123 Fd Sgn
(b) OPCON BC/FOOs 123 Fd Bty
(2)  Tasks.
@ Adv LEFT forward
(b) Fix en in Obj A.
(©) Provide one inf coy as bde reserve until phase 3 consolidation  along

Highway 8/9A
(d) Cross BIG TOP in the area of Obj B 1.

)] Consolidate along Highway 8/9A and be prepared to continue the
adv to Obj LAMB.
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1 CH of 0.

@ Grouping.
(@) OPCOM Sgn R de Hull
127 Armd Engr Sgn (-)
()  OPCON BC/FOOs 121 Fd Sgn
(2)  Tasks.
@ Advance RIGHT forward.
(b) Seize Obj B2.
©) On order seize Obj C2.
(d) Consolidate along Highway 8/9A and be prepared to continue the

adv to Obj LAMB.

B Coy R West R.

1) Tasks.

(@)
Artillery

LEFT flank security throughout.

@ Field Artillery.

(@)

Tasks.
i. 12 Fd Regt DS to 12 Bde
ii. 14 GS Regt Reinforcing 12 Fd Regt

2 Locating Artillery.

(@)

(b)

Drones. Div controls all assets, with priority to en Arty, command
and control, and NBC systems. Requests to Bde HQ FSCC for
coordination higher.

Remotely Piloted Vehicle. Div controls all assets with priority to
counterbattery. 12 Bde allocated one UAV mission daily effective
0001 hrs 17 May. Msns regr six hrs planning time. UAV results
transmitted to Bde HQ within 30 min of return. Requests to Bde
HQ FSCC for coordination.

3 Air Defence Artillery. Task. 161 AD Bty (-) (SHORAD) direct support 12

CIB.

4 Coordination.

(a)

Ammunition Allocation.
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Ser Tasks RPG/

Salvo
(a) (b) (c)
1 Initial breakdown of Bde 50/1
2 Advance to contact 300/3
3 Support 25 AD and 52 ID passage of Lines 50/1

(b) Countermortar Policy . ACTIVE

©) Air Corridor/Low Level Transit Route. To_be issued.

(d) Weapons Control Status.

i. Air Defence Units. Weapons TIGHT.

ii. All-arms Air Defence. Weapons HOLD.

(e Air Defence Emission Control (EMCON) . EMCON 3.

()] Air Defence Priority

I. Lead BGs/Bns.

ii. Crossing sites at BIG TOP.
iii. Reserve.

iv. Bde HQ.

Engineers.
@ Coordination. CO 12 CER

2 Grouping.
(@ OPCOM R de Hull 121 Fd Sgn
(b) OPCOM1E & K Scots 125 Fd Sgn
two tps 127 Armd Engr Sgn
(c) OPCOM 1R de Mais 122 Fd Sgn
(d) OPCOM1CHof0 127 Armd Engr Sqn (-)

3) Tasks. Mobility support to forward BGs.

Coordinating Instructions.

1) Timings.
@ Recce Crosses LOD - 0500 hrs 17 May
(b) H-Hr - 0600 hrs 17 May

) Movement and Traffic Control. See Move order 01 at annex C.
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3) Boundaries. Report Lines. Coordination Points. Locations: Fire Plan. See

annex F.
4 Barrier Plan. See annex G.
() Mines and Explosives. See annex G.
(6) Intelligence, Surveillance. Target Acquisition and Reconnaissance
(ISTAR).
See Annex H.

(7 Nuclear Biological Chemical. TOPP LOW

(8) Reconnaissance. No restrictions.
9  Air

(10)  Public affair plan. See Annex E.

(11)  Coordinating Conference.

SERVICE SUPPORT

a. Administrative Order. See annex B.

COMMAND AND SIGNAL

a. Alternate Commander. CO R de Hull

b. Locations.
Q) Main HQ ; REINBSBURG US 856 533
2 Alternate; BSA

C. EMCON. EMCON3
d. Signals . Communications-electronics operating instructions (CEOI) 02 in effect.
e. Code Words.
Ser Code Words Meaning Issued By
(a) (b) (©) (d)
1 BALDER Obijective A seized 1 R de Mais
2 LOKI Objective B seized 1E & K Scot
3 ODIN Obijective C seized R de Hull
4 THOR Objective HAMMER seized HQ 12 CIB
f. Nicknames.
Ser Nicknames Meaning
(a) (b) (©
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1 BIGTOP SCHWARZE ELSTER CANAL
2 BILLY BOB Limit of Exploitation

3 CLOWN FACE Line of Departure

4 RING MASTER Highway 102

5 TINCUP River ELBE

Acknowledge Instructions: ACKNOWLEDGE

C. Bradley
Maj
G3 for Comd
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Annexes:

Annex A: Administrative order

Annex B: Move order 01

Annex C: Boundaries, Report Lines, Coordination Points, Locations

Annex D: Public affair plan

Annex E: Fire plan

Annex F: Barrier, mines & explosives plans

Annex G: Intelligence, Surveillance, Target Acquisition and Reconnaissance (ISTAR)

DISTRIBUTION: (next page)
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The purpose of this article is a step by step description of how to use the Electronic Battle Box (EBB
suite v.2.1) to generate logistics data. First, we introduce the EBB Suite’s components. Then we extract
some relevant information from an operation order at the brigade level and reorganise it in the way to
fit the EBB Suite structure. Finally, we enter this information within the EBB Suite browsers and
process it in multiple ways, using each time a different planner of the EBB Suite.
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